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Getting Started

The Bion threat and how to defeat it
System requirements
Using the keyboard
Using a joystick
Using a mouse
Selecting joystick, gamepad, or keyboard
Selecting mono, stereo, or surround sound
How to play



Playing 

Starting a new game
Scoring and levels of difficulty
Choosing the level of difficulty 
Displaying the high score 
Pausing during a game
Muting the sound
Saving a game for later play
Saving a game under a different name
Resuming a saved game
Ending a game without exiting
Exiting 



Navigating

The planets
Displaying or hiding the Satellite Map
Locating targets, checkpoints, and tunnels
Moving to the next planet



Views and Instrument Display

The Instrument Panel
Satellite Map, description
Changing the instrument display
Views, overview
Looking out the cockpit windows
Viewing your ship from the outside
Changing the view to speed up game play
Hiding or displaying the menu bar



Weapons, Targets, and Enemies

Targets, overview
Tunnels, overview
Enemies, overview
Weapons, overview
Picking up weapons
Selecting and firing a weapon
Hiding or displaying the crosshairs



Shields and PowerUps

PowerUps, overview
Increasing shield strength
Attaining temporary invincibility or invisibility
Activating Turbo Thrust
Increasing or decreasing velocity



Customizing 

Turning Quick Help on or off
Customizing keyboard settings
Customizing joystick settings
Calibrating the joystick
Turning game videos on or off
Turning planet briefings on or off
Turning the flight demo on or off
Adjusting sound volume
Muting the sound
Selecting mono, stereo, or surround sound
Listening to the bonus soundtracks
Increasing game speed by decreasing graphic detail
If your monitor display setting is higher than 256 colors
If the graphics have less detail than you would like
If game play is slower than you would like



Tips and Troubleshooting

Tips
If you don't hear any sound
If the sound seems clipped, or the sound effects are delayed
If  displays a message asking for the CD-ROM

If your monitor display setting is higher than 256 colors
If the graphics are not as smooth as you would like
If the graphics have less detail than you would like
If game play is slower than you would like
If you are flying upside down and don't want to be

If the ship's instruments are not displayed
If the cockpit is not displayed
If the joystick does not function correctly
If the keyboard does not work as expected
If the + and - keys don't work



The Bion threat and how to defeat it

During the IP Wars, the Terrans designed a race of bionic warriors known for their cunning and their brutal 
strength. Physically superior and ruthlessly aggressive, a single troop of Bions could eliminate the inhabitants of a 
planet within days.
The Bion war effort saved the Coalition, but nearly destroyed Terran. After the war, Bion aggression could not be 
contained. Peaceful coexistence between Bions and Terrans proved impossible. The ensuing Bion Wars are known 
for their brevity -- and violence.
In 2832, the Coalition ordered complete Bion dismantlement and instituted Terran's renowned Council of Peace -- a
military defense force inferior to none.... Unknown to the Coalition, a few Bions survived and have assembled on a 
distant planet called Fury.
The Bion plan is to seize seven more Coalition planets whose resources will help them attain their ultimate goal -- 
total domination of space from the Bion Fury outpost.
As a member of the Council of Peace, it's your mission to stop them.
Welcome home, Councilor.

Defeating the threat

As a member of Terran's Council of Peace, your role in this intergalactic war is crucial. Bring down the Bions and 
peace is restored. Allow the Bions to succeed, and you can kiss the Coalition good-bye.
Trust the intelligence report for each planet. It provides you with the latest information concerning Bion infiltration,
and satellite views of critical Bion targets. Also trust your ship. Its Compass, when used with the Distance 
Indicator, will help you steer straight toward a Bion target. 
Each planet contains three separate missions. Once you've successfully completed all three missions, your ship 
will transport you to the next planet. Intelligence has sighted Bion infiltration on eight planets in all.... The last 
planet is a killer.
Be ruthless, Councilor. The Bions are.



How to play 

Objective

Destroy all mission-critical targets, eliminating as many other targets as you can along the way.

Targets

Each planet contains 3 missions. To complete a mission, you must eliminate all mission-critical targets. Here's 
how:
1 Keep your Compass pointed straight up -- it's programmed to guide you to these mission-critical targets.
2 Watch the Distance Indicator. It will approach "0" as you approach a target. 
3 Look at the Objective Tracker. It will indicate what your next target is.
4 Blast the target to bits!
After you've completed a planet's third mission, the Coalition will transport you to the next planet, often via a 
Jump Zone.

Shield strength

Maintain your shield strength -- the more you have, the more likely you are to reach the next planet alive.
Keep an eye out for floating powerUps. Some have the power to restore your shields.
Watch your Shield Strength Register. When it's drained, your ship will nosedive. You'll have to start the mission 
from the beginning, unless you saved along the way.

Weapons

When you see a hovering weapons cache, fly straight toward it to upload the goods. Then select the weapon you
want to fire by pressing the key assigned to it.

To activate Press

ServoKinetic Laser (SKL) 1
Dispersion Cannon 14 
(DC14)

2

Rapid-Fire Laser (RFL20) 3
Dead-On Missile (DOM) 4
Viper (VIP) 5
Bion Fury Missile (BFM) 6
 (FFF) 7

Strategy

After you've destroyed a mission-critical target, consider your next move carefully. 
The quickest way to get off a planet is to go directly to the next mission-critical target. 
For a higher score, blast everything in sight. 
Press TAB to use the Satellite Map and plan optional sorties to remote targets and tunnels.

See also
Moving to the next planet
Scoring and levels of difficulty
The Instrument Panel



Displaying or hiding the Satellite Map
Locating targets, checkpoints, and tunnels



Scoring and levels of difficulty

All hits are valued equally. You receive 100 points per air or ground hit. Spare the greenery -- palm trees and 
seaweed are not the enemy. You'll lose 100 points for each one you destroy. 
Too easy? For a more aggressive enemy with greater firepower, choose a harder level of play. Enemy firepower 
and reckless flying take their toll on your ship. When your shield strength is gone, so are you. 
Coalition reconnaissance confirms your hits after each mission. Satellites also search for and report damage to 
vegetation. Palm tree and seaweed losses are reported in the "green" category on your mission summary. If 
records indicate that you are among the Coalition's top ten pilots, your name is placed on the High Score roster. 
The best of this elite group traditionally leaves an inspirational message.

See also
Choosing the level of difficulty
Displaying the high score



To move to the next planet

The Coalition has a policy about unfinished business. Finish what you start, or what you've started may finish off 
the Coalition.
Based on this philosophy, the Coalition has programmed a series of mission-critical objectives into your ship. As 
soon as you achieve the last objective on a planet, your Objective Tracker may indicate that a Jump Zone is your 
next goal. 
Jump Zones house the energy and data required to transport you to the next planet. You locate Jump Zones the 
same way you locate any target -- with your Compass and Distance Indicator.
If you succeed in reaching a Jump Zone, your ship locks into autopilot for transport to the next planet. You'll fly at a
speed faster than Bion war ships can follow. This could be your only breather for quite a while. Enjoy.
Reconnaissance indicates that some of the Jump Zones have been destroyed. Use your instincts. The Coalition 
monitors the activities of planet Guardians. If you succeed in destroying a Guardian, the Coalition will do 
everything in its power to get you off the planet alive.

See also
The planets, overview
Locating targets, checkpoints, and tunnels



To speed up game play by changing the format

Game speed is determined by your hardware and the graphics display that you choose. The three levels of graphic
display are:
Normal -- Press F4 to switch to Windows mode (menus and taskbar displayed).

Faster -- Press F4 to switch to Full Screen (no menus or taskbar).

Fastest -- Press [    ] (bracket keys) to switch in or out of Panoramic format.

Tips
Within any of these graphic displays, you can change the instrument display by pressing C repeatedly, and

the pilot view by pressing V repeatedly.
When you press F4 to switch between Windows mode and Full Screen format, game play may be 

interrupted momentarily while 
 changes the display.

See also
Changing the instrument display
Viewing your ship from the outside



PowerUps

After you destroy a Bion bunker, you may discover a treasure trove of stashed powerUps. Don't ask how they got 
there, just take them as you see them, and run. 

Shields Restored

Fly through the rotating shield and your shields will be restored to 100%.

Shield Boost

Pick up a hovering radon battery core and watch your shield strength go up 25%.

Turbo Thrust

Turbo Thrust fuel makes the speed of light seem slow. Grab the floating fuel injection engine and, when the 
moment seems right, press Button 2 on the joystick or press F on the keyboard to let your ship r-i-p!

Invisibility

If you come across a glowing red orb, by all means grab it. A timer in the lower-right corner of your screen counts 
down the 30 seconds that the Bions won't be able to tell you're around. There's nothing like flying next to an 
enemy when he doesn't know you're there. 

Invincibility 

Fly through the glistening blue orb and fear no more. Let the bombs drop! You won't feel a thing. DO watch the 
timer in the lower-right corner of the screen so you'll know when you're about to lose your invincible edge.



To display or hide the Satellite Map

To display the Satellite Map and pause the action:
Press TAB. Or, on the View menu, click Map. 

To hide the Satellite Map and resume battle, repeat the procedure.



System Requirements
To run  you need:

486DX/66 MHz or higher processor
8 MB of RAM
Either:

- Microsoft® Windows 95® operating system
or
- MS-DOS® operating system version 5.0 or later with Microsoft® Windows® operating system version 3.1 or 

later
Available hard disk space:

- For Windows 95, 10 MB of available hard disk space
- For Windows 3.1, 14 MB of available hard disk space, plus a 10 MB swap file if you have less than 12 MB of 

RAM. See the README for more information
Double-speed or faster CD-ROM drive
Local bus SVGA video, 256-color display
Sound board plus speakers or headphones to hear audio

Recommended
Joystick or other flight control
Microsoft Mouse or other pointing device
For best play:

- Under Windows 95, 55 MB of available hard disk space
- Under Windows 3.1, 70 MB of available hard disk space



To turn Quick Help on or off
1 On the Help menu, click Quick Help.
2 Check or clear the Skip Quick Help at Startup check box.
When Skip Quick Help at Startup is cleared,  displays the Quick Help dialog box every time you start 

.

See also
The Bion Threat and How to Defeat It
Scoring and levels of difficulty
Choosing the level of difficulty
Picking up weapons
Selecting and firing a weapon
Using the keyboard
Using a joystick



Quick Help

Objective
Complete 3 missions on each of eight planets by eliminating all mission-critical targets. Destroying other 

ships or installations will increase your score.
Strategy

To locate a mission-critical target, maintain a 12 o'clock Compass heading and watch your ship's Distance 
Indicator. When the Distance Indicator reaches "0," you're there.

Flight Control: Arrow Keys
Fire Weapon: SPACEBAR



Using the keyboard

You can use the keyboard to control your flight, weapons, views, and game play.

Flight controls

To Press

Increase/decrease 
throttle

A/Z

Bank left/right     
Nose up/down     
Roll left/right HOME/PAGE UP
Turbo Thrust F
Display/hide 
Satellite Map

TAB

Weapons

To Press

Select weapon
Fire weapon
Display/hide 
crosshairs

1-7
SPACEBAR
X

Views

To Press

Cycle through pilot 
views

V

Cycle through 
instrument displays

C

In Outside View, 
pan: 
Left/right INS/DEL
Up/down - / + (KEYPAD)
Center PERIOD (.)
Full Screen on/off F4
Show/hide mission 
status

BACKSPACE

Cockpit windows

To Press

Look out window:



Up
Left/right

- (KEYPAD)
INS/DEL

Game play

To Press

Start new game
Pause/resume
Minimize game
Save game for 
later play
Display Help
Mute sound
Resume saved 
game

F2
F3
ALT, SPACEBAR, N
CTRL+S

F1
CTRL+M
CTRL+R

See also
Customizing keyboard settings



Using a joystick

To Press

Fire weapon Button 1
Turbo Thrust Button 2
Decrease throttle Button 3
Increase throttle Button 4
Adjust throttle Throttle 

Control

In Cockpit view:
Look out cockpit 
windows

Hat Switch

In Outside view:
Pan up, down, left, right Hat Switch

See also
Customizing joystick settings
Calibrating the joystick



Using a mouse

You can use a mouse or other pointing device to choose commands from the menus. The mouse does not affect 
flight control. 



To start a new game
1 If you are currently playing a game, you will need to end it by pressing ESC or by clicking End Game on the 

Game menu.
2 To start a new game, on the Game menu, click New Game or press F2.
Important: If you are ending a game, you may want to save it before starting another one. If you choose to end 
the game without saving it, you will have to repeat any missions you completed during the game to continue your 
journey.



To pause during a game
To pause or resume a game, on the Game menu, click Pause Game or press F3.

The game also pauses when you:
Press P or the PAUSE key.
Display a menu.
Press F1 for Help.
Press TAB to display the Satellite Map. 

Tip
World invading your flight pattern? You can instantly pause and minimize  by pressing ALT, SPACEBAR, N. When 
your earthly duties are complete, you resume battle in Windows 95 by clicking 

 taskbar icon. In Windows 3.1, double-click the 
 icon.



To end a game without exiting 
On the Game menu, click End Game or press ESC.

Important: To resume action where you left off, you'll need to save the game before ending it. If you choose to 
end the game without saving, you will have to repeat any missions you have completed to continue your journey.

Tip
You can press ESC to end a game, or you can press ALT, SPACEBAR, N to instantly pause and minimize a game 
for later play.

See also
Saving a game for later play
Exiting 



To exit 
On the Game menu, click Exit or press ALT+F4.

Tip
To maintain progress on your journey toward the planet Fury, you must save your game before ending it or 
before exiting . If you prefer to minimize 

 instead, press ALT, SPACEBAR, N. 

See also
Ending a game without exiting



To save a game
On the Game menu, click Save Game or press CTRL+S.

To maintain progress on your journey toward the planet Fury, you must save before ending a game. When you 
save,  stores your score, your location, your onboard weapon inventory, and your achievements. 

Flight information is normally stored in the Data folder of your  folder.
Important: Be forewarned that tunnels are especially dangerous. Radio communications cannot reach the 
Coalition. Once you enter a tunnel, you're on your own until you exit. Your request to save will not be heard.

Tip
Surrounded by pesky Bions? About to enter a subterranean space? Face to face with a planet Guardian? Press 
CTRL+S to save the game, then fight it out knowing you can travel back in time for a second chance. Otherwise, 
lose your footing and you're back to square one.

See also
Saving a game under a different name
Resuming a saved game



To save a game under a different name
1 On the Game menu, click Save Game As.
2 Type a new filename.
3 Select the drive where you want to store the game.
4 Select the directory where you want to store the game.
To save a game using an existing filename, choose the name in the list or type the current name. When you click 
OK, you will need to confirm that you want to replace the existing game. 



To resume a saved game
1 On the Game menu, click Resume Saved Game, or press CTRL+R.
2 Click the drive, folder, and filename of the game you want to play.
Action picks up where you left it. Any weapons you acquired are still onboard.



To choose the level of difficulty

When you begin a game, you must choose the level of difficulty you want for your assignment. These are the 
Coalition's ratings:

Level Effect on mission 
assignment

Easy You fly with double-strength 
shields and a pulsating 
interference device so fewer 
enemy ships find you.

Normal Your reputation draws increased 
enemy activity and twice the 
firepower that lesser pilots are 
exposed to.

Hard Reputations can be deadly. More
enemy ships than your 
nightmares can handle.

Furious It's you versus the most 
aggressive war machines ever 
created. THEY decide if you're 
up to the task.

Tip
The Auto Leveler assists in keeping your ship parallel to the horizon. If you are an experienced pilot who loves a 
challenge, consider turning your ship's Auto Leveling system off. With it off, you can make sharper turns and take
on the demands of total flight control. To turn Auto Leveling off, click Options, click Flight Controls, and then clear
the Auto Leveling check box.



To locate a target, checkpoint, or tunnel
1 Check the Objective Tracker to determine what you're looking for.
2 Maintain a 12 o'clock Compass heading.
3 As the Distance Indicator nears zero, get ready for action.

Tip
The PLUS and MINUS SIGNS on the Compass indicate the position of targets, tunnels, checkpoints, and 
powerUps. Although many may not be mission-critical, they can significantly affect your career as a pilot. High-
scoring pilots owe much to being thorough. To pause the game and study a Satellite Map that shows a larger 
geographical area, press TAB.

See also
The Instrument Panel
Displaying or hiding the Satellite Map



To pick up weapons

The Bions have stolen the more valuable Coalition weapons. Some of the stolen weapons are stashed in 
subterranean spaces, and some are stored above ground in well-guarded locations. 
When you destroy a Bion bunker, your stolen weapons are extracted and stored indefinitely for you in a floating 
weapons cache similar to the ones in the subterranean areas. Fly through a cache to:

Upload new weapons 
Add ammo for onboard weapons 

Tip
When you pick up a weapons cache, the name of the weapon is displayed for a moment along with the key you 
press to activate the weapon. For example, if you harvest a Viper cache, the message reads:    Vipers! (5).

See also
Selecting and firing a weapon



To select and fire a weapon
1 After you have picked up weapons in a powerUp, select the weapon you want to fire by pressing the key 

assigned to it.

To activate Press

ServoKinetic Laser (SKL) 1
Dispersion Cannon 14 
(DC14)

2

Rapid-Fire Laser (RFL20) 3
Dead-On Missile (DOM) 4
Viper (VIP) 5
Bion Fury Missile (BFM) 6
 (FFF) 7

2 Press Button 1 on the joystick, or press SPACEBAR.
Your Weapon Readout indicates the active weapon. The Ammunition Inventory shows the quantity of the active 
weapon.

Tips
You begin your intergalactic journey with only one weapon -- a ServoKinetic Laser. The other six weapons 

are stored in secret caches underground or above ground in well-guarded locations.
Lasers regenerate their own ammo. Missiles are finite; you'll have to scour the universe to find 

replacements. FFF bombs are a serious threat and a serious payload -- you can carry only one at a time, but one is 
more than enough.

See also
Customizing keyboard settings
Customizing joystick settings
Picking up weapons



To increase shield strength

Your ship identifies atmospheric energy fields and rechannels them into floating energy caches. Fly through a 
cache and watch for these messages:

Message Effect

Shields 
Restored!

Full restoration of 
shield strength

Shield Boost! Adds 25% to shield
strength

If you locate an energy cache when your shields are close to full strength, your ship will not upload the cache. 
Note the coordinates of the cache's location. You can come back for it later when you need it.
Important: Watch your Shield Strength Register. When your shield strength is gone, so are you.

Tip
Pilots who request Easy missions are issued ships with double-strength shields.

See also
Choosing the level of difficulty



To achieve temporary invincibility or invisibility

Your ship identifies atmospheric energy fields and rechannels them into floating energy caches. Fly through them 
and watch for these messages:

Message Effect

Invincibility
!

30 seconds of 
total invincibility

Invisibility! 30 seconds of 
invisibility

Tip
A countdown timer appears in the lower-right corner of your screen for the 30 seconds that your ship is invisible 
or invincible. 

See also
Locating targets, checkpoints, and tunnels



To increase or decrease the ship's velocity

You can increase or decrease your ship's velocity using the joystick or the keyboard.

Joystick method

To Press

Increase 
throttle

Button 4 or 
Throttle Control

Decrease 
throttle

Button 3 or 
Throttle Control

Keyboard method

To Pres
s

Increase 
throttle

A

Decrease 
throttle

Z

The Velocity Register indicates your relative speed.

See also
Activating Turbo Thrust
Customizing keyboard settings
Customizing joystick settings



To activate Turbo Thrust
To activate Turbo Thrust, press Button 2 on the joystick or press F on the keyboard.

Before you can use Turbo Thrust, you have to find the fuel by either: 
Picking up a hidden fuel cache in a subterranean space
Retrieving stolen Coalition fuel from a well-guarded location. 

Turbo Thrust provides an intense burst of speed for emergency situations. Use it as a defensive tactic for high-
powered escapes. You cannot fire a weapon while it is engaged; all the ship's power is channeled into the 
propulsion and navigation system for the duration of the Thrust. Forget the trigger. Get a white-knuckle grip on 
something stable. 
The Ammunition Inventory shows your fuel level during a Thrust. 

Tips
Save a little Turbo fuel for use in tunnels, where timing, finesse, and a short but serious burst of speed can 

get you past a deadly trap.
If you are scrutinizing the terrain for targets, tunnels, and powerUps, consider throttling down and using 

short bursts of Turbo Thrust if a blast of speed is needed. Not recommended for those prone to whiplash.

See also
The Instrument Panel
Locating targets, checkpoints, and tunnels



To look out the cockpit windows

To look Press

Left INS
Right DEL
Up - (KEYPAD)

Tips
If you can see the exterior of your ship on the screen, you are in Chase or Outside view and you can't look 

out the cockpit windows. To switch to a view where you can look out the cockpit windows, on the View menu, click 
Pilot View, and then click Cockpit.

Thanks to a highly advanced visual guidance system, your tracking missiles will fire in the direction you are
looking.



To view your ship from outside
On the View menu, click Pilot View, and then click Chase or Outside. Or press V repeatedly to cycle through

Chase view, Outside view, and the last cockpit view you displayed.
Last cockpit view
you displayed

Chase view
Gain more 
visibility to the 
left and right.

Outside view
Change your 
point of view by 
panning 
up/down/left/righ
t.

In Outside view, you can pan around your ship by pressing the Hat Switch on your joystick, or by using the 
keyboard.

To pan Press

Left/right INS/DEL
Up/down - / + (KEYPAD)
Center PERIOD (.)

To change the size of  on the screen by hiding the menu bar
To fill the screen with 

 and hide the task and menu bars, press F4. Press F4 again to display the bars. Full Screen format often makes the 
graphics appear smoother. There may be a momentary interruption in the screen display while 
 switches to or from Full Screen format.

Tip
For faster action in Full Screen format, fly with a Head-Up Display or No Instruments instead of Full Cockpit. Use 
the View menu to choose your instrument display, or press C repeatedly to cycle through the displays.

See also
Changing the view to speed up game play



To customize keyboard settings
1 On the Options menu, click Flight Control Options.
2 Click Customize Keyboard.
3 Click the item that you want to change.
4 Click Change.
5 On the list, click the key you want to use.



To customize joystick settings

Your joystick must be calibrated before you can customize joystick settings.
1 On the Options menu, click Flight Control Options.
2 Make sure Joystick is chosen in the Primary Flight Control box.
3 Click Customize Joystick.
4 Click the item that you want to change.
5 Click Change.
6 Press the joystick button (other than the Hat Switch) that you want to use.



To select a joystick, gamepad, or keyboard as primary flight control
1 On the Options menu, click Flight Control Options.
2 In the Primary Flight Control box, click the device you prefer.

Tip
If you are using a Thrustmaster joystick, see the README for more information.



To calibrate the joystick
1 On the Options menu, click Flight Control Options.
2 Click the Calibrate button to open the Joystick Calibration dialog box.
3 Follow the instructions in the dialog box.
When the calibration is complete, you return to  Primary Flight Control dialog box.



To turn planet briefings on or off
1 On the Options menu, click Game Options.
2 Click the Show Planet Briefings check box.
When Show Planet Briefings is checked, each new planet begins with a description of the planet and its targets. 

Tip
During a planet briefing, you can skip to the next item in the briefing by pressing SPACEBAR, or you can leave 
the planet briefings and begin flight by pressing ESC.

See also
Turning game videos on or off
Turning the flight demo on or off



To turn videos on or off
1 On the Options menu, click Game Options.
2 Click the Show Videos check box.
When Show Videos is checked,  displays cinematic footage from critical junctures on your journey. The videos 
include footage of your ship being launched from the mother ship and other clips from your ship's voyage through 
space. 

Tip
Depending on the options you chose during Setup, the  CD-ROM may need to be inserted in your CD-ROM drive 
to play the videos. If the CD-ROM is not inserted, 

 skips the videos and continues with the game.

See also
Turning planet briefings on or off
Turning the flight demo on or off



To turn the demos on or off
1 On the Options menu, click Game Options.
2 Click the Show Demo When Idle check box.
If this option is checked and you go 30 seconds between games without touching the controls,  begins a virtual 
flight pattern while searching for a human heartbeat. The flight pattern ends when you demonstrate signs of life, 
such as pressing a key or clicking New Game on the Game menu.

See also
Turning game videos on or off
Turning planet briefings on or off



To increase game speed by decreasing graphic detail
1 On the Options menu, click Graphics.
2 To increase game speed, choose a lower level of detail for the options. Experiment to find the balance you want 

between speed and graphic detail.
Your display is updated when you return to game play.

See also
Changing the view to speed up game play
If the graphics have less detail than you would like



To adjust the volume of music and sound effects
1 On the Options menu, click Sound Options.
2 In each volume box, click the volume level you want.

Tip
You can clear the Play Sound Effects check box or the Play Music check box to turn music or sound effects off 
entirely.

See also
Muting the sound



To set the playback format for mono, stereo, or surround sound
1 On the Options menu, click Sound Options.
2 In the Playback Format box, click the type of sound that matches your sound system.



To mute the sound
On the Options menu, click Mute, or press CTRL+M.

Ah, the silence of deep space. To return the sound to its previous level, repeat the process.

Tip
Music and sound effects can be turned off independently of each other. On the Options menu, click Sound 
Options, and then clear the check box of the item you do not want.

See also
Adjusting sound volume



To display the high score
On the Game menu, click High Score.

 displays the high scores next to the call signs of pilots from past missions -- a Coalition Hall of Fame. 
All hits are valued equally. Air and ground targets are worth 100 points each, and "green" targets (palm trees and 
seaweed) are counted against you -- 100 points off for each.
The inspirational message is written by the all-time best pilot.

See also
Scoring and levels of difficulty



To change the instrument display
On the View menu, click Instrument Display, and then choose the display you prefer.

Full Cockpit

Head-Up Display
No Instruments

Tip
You can press C repeatedly to cycle through these displays.

See also
Views, overview
The Instrument Panel
Viewing your ship from the outside



To display or hide the crosshairs

The crosshairs are your sighting device. You can hide them for totally unobstructed flight, and then display them 
again when you want total accuracy in battle. 

Press    X to toggle the crosshairs on or off.



To play the bonus soundtracks

The  CD provides five soundtracks in addition to the music for the game. These five bonus tracks can be played 
on any standard CD player. Always turn down the volume of your CD player before inserting a disc.

Track 1 Caution: Track 1 is not intended for 
audio playback. It contains game data 
only.

Track 2 Overture
Track 3 Sebek
Track 4 Ares
Track 5 Fury
Track 6 Premonition

Pilot Registration dialog box

Pilot Call Sign

Type the name you want to be known by when you fly for the Coalition -- the name you want to see at the top of 
the high-score list. 

Difficulty Level

Establishes how difficult a mission you will fly. You must finish out your assignment on this level. To request a 
different level of difficulty, you must start a new game. These are the Coalition's ratings: 

Level Effect on mission assignment

Easy You fly with double-strength shields 
and a pulsating interference device 
so that fewer enemy ships find you.

Normal Your reputation draws increased 
enemy activity and twice the 
firepower that lesser pilots are 
exposed to.

Hard More enemy ships than your 
nightmares can handle.

Furious It's you versus the most aggressive 
war machines ever created. THEY 
decide if you're up to the task.

Game Options dialog box

Show Planet Briefings

Provides reconnaissance on a planet and its missions during the introduction to each new planet. 

Show Videos

Displays the introductory launch sequence from the mother ship and cinematic sequences between game levels. If
you chose the Compact installation option, the  CD-ROM must be inserted in the CD-ROM drive to run the 
cinematic sequences. If the CD-ROM is not inserted, 

 omits the videos and continues with game play.

Show Demo When Idle

Displays a virtual flight pattern when you are not in a game. The flight pattern ends when you press a key or click 



New Game on the Game menu.



Graphics Options dialog box

Adjust the detail of each setting lower to increase game speed, or higher for the best-looking graphics.

Shadow Detail

Displays the shadows of all ships in the air. Shadows can be useful for judging your own altitude or for spotting 
enemy aircraft lurking behind you. Choose None if you are afraid of your own shadow -- or want faster game play.

Image Quality

Choose higher image quality for more realistic texture mapping and a sharper image.

Texture Detail

The higher the detail, the more elegant the landscape.

Debris

Controls the amount of flying debris from destroyed targets. Choose from these options:

Off: Direct hits create a compact 
implosion that is faster to fly through.

Normal
:

Direct hits create your average 
explosion with just enough debris to 
confirm the hit.

Overkil
l:

Direct hits create serious explosions 
that can light up a dark planet but 
tend to slow your flight.

Show Sky Texture

If this option is not checked, the sky is a solid color without clouds.



Sound Options dialog box

Play Sound Effects

Plays explosions, crashes, and other sound effects during a game.

Play Sound Effects Volume

Adjusts the volume of explosions, crashes, and other sound effects during a game.

Play Music

Plays background music during a game.

Play Music Volume

Adjusts the volume of the background music during a game.

Playback Format

Sets the playback format to mono, stereo, or surround sound.

Advanced button

During Setup,  estimates settings for playing sound on your computer's sound card. You can click the Advanced 
button to view and adjust the settings if you need to troubleshoot a sound problem. 



Advanced Sound dialog box

To eliminate clipped or choppy sound or improperly timed sound effects, experiment first with the number of 
buffers, and then with the buffer length. Use the Test button to apply the settings and hear the result. See the 
README for more information about buffer size and number of buffers for specific cards.

Buffer Length

Increase slightly to smooth out clipped or choppy sound. Decrease slightly if sound effects seem delayed.

Number of Buffers

Increase slightly to smooth out clipped or choppy sound. Decrease slightly if sound effects seem to last too long.

Default button

Restores the settings that  estimates for your sound card.

Test button

Applies the settings so you can evaluate the results.



Save Game As dialog box

File Name

To save a game with a new name, type a new filename.
To save a game using an existing filename, choose the name in the list or type the current name. When you click 
OK,  asks if you want to replace the existing game. 

A Windows 3.1 filename can contain up to eight characters, plus the .FFF extension.

Drives

Choose the drive where you want to store the game.

Directories

Choose the directory where you want to store the game.



Flight Control Options dialog box 

Allows you to select your primary method of controlling your ship. If necessary, you can also calibrate your 
joystick. If you want to change flight control settings, click the Customize Keyboard or Customize Joystick button.

Primary Flight Control

Determines your primary method of maneuvering your ship and firing weapons. 

Calibrate button

Opens the Joystick Calibration dialog box, where you can calibrate the joystick for accuracy in maneuvering the 
ship. Your joystick must be calibrated before you can customize joystick settings.

Customize Keyboard button

Opens the Customize Keyboard dialog box, where you can view and change the current keyboard functions of .

Customize Joystick button

Opens the Customize Joystick dialog box, where you can view and change the current joystick button settings. 
Your joystick must be calibrated before you can customize joystick settings.

Tips
Before you can customize your joystick settings, you'll need to calibrate your joystick by clicking Calibrate.
The keyboard controls always work, regardless of any other selection you make.



Customize Joystick dialog box

To change a joystick button setting, choose the item you want to change from the Joystick Settings list, and then 
click Change. To return customized joystick settings to their default settings, click Default. Your joystick must be 
calibrated before you can customize joystick settings.

Joystick Settings

Lists current settings for the joystick buttons that you can change.

Change button

Opens the Change Joystick Button Setting dialog box where you assign the selected item to a different joystick 
button.

Default button

Resets joystick buttons to the following settings:

Button Default setting

1 Fire weapon
2 Turbo Thrust
3 (if 
available)

Decreases throttle

4 (if 
available)

Increases throttle

Throttle 
Control (if 
available)

Adjusts throttle

Hat Switch
(if available)

In Full Cockpit view :
Looks out cockpit windows
In Outside view:
Pans left, right, up, down

Customize Keyboard dialog box

To change a keyboard setting, click the item you want to change, and then click Change.
To restore keyboard settings to the following defaults, click Default.

To Press

Increase/
decrease 
throttle

A/Z

Bank left/right     

Nose up/down     

Roll left/right HOME/PAGE UP
Fire weapon SPACEBAR
Turbo Thrust F

Restore All Settings dialog box

If you are currently changing keyboard settings



To leave keyboard settings as they currently are, click No.
To return all keyboard settings to the following defaults, click Yes. 

Default Keyboard Settings:

To Press

Increase/
decrease 
throttle
Bank left/right
Nose up/down
Roll left/right
Fire weapon
Turbo Thrust

A/Z

    
    

HOME/PAGE 
UP
SPACEBAR
F

If you are currently changing joystick settings

To leave joystick settings as they currently are, click No.
To return all joystick settings to the following defaults, click Yes. 

Default Joystick Settings:

Button Default setting

1 Fire weapon
2 Turbo Thrust
3 (if 
available)

Decreases throttle

4 (if 
available)

Increases throttle

Change Joystick Button Settings dialog box

Pressing a button on the joystick now replaces the button's current function with the function you chose in the 
Joystick Settings list.
To leave the joystick button setting as it is, click Cancel.



Change Key Setting dialog box

Choose a key from the dropdown list to replace the key's current function with the function you chose in the 
Keyboard Settings list.
To leave the key setting as it is, click Cancel.



Resume Saved Game dialog box

To resume a game that you've saved, choose the drive and directory where it is stored, and then choose the 
filename of the game. Click the Find File button if you are not sure where the game is stored.

Dialog Box Options

File Name

Choose or type the name of the game you want to play. 

Drives

Choose the drive that contains the game you want to play.

Directories

Choose the directory that contains the game you want to play.

Find File button

Opens the Find File dialog box so that you can search for saved  games. 



Targets

Some of the targets you need to destroy are none other than the inventions of bionic warrior insurgents, whose 
aim is to rule the Coalition and control all of space. These targets may look innocent... but don't be fooled. For 
example, the Grim Reaper is distinguished by its ability to think as well as fly, and was the first Bion fighting ship 
invented.
Other targets were originally Coalition inventions, but have now been co-opted by the Bions to do no good. For 
instance, Scarab Fighters were used to protect Sebekian caravans transporting precious alloys and gems. Now 
they're being used for evil purposes by the Bions. 
The message of all this is simple: destroy or be destroyed. 

See also
Locating targets, checkpoints, and tunnels



Enemies

During the IP Wars, the Terrans designed a race of bionic warriors known for their cunning and their brutal 
strength. Physically superior and ruthlessly aggressive, a single troop of Bions could eliminate the inhabitants of a 
planet within days.
The Bion war effort saved the Coalition, but nearly destroyed Terran. After the war, Bion aggression could not be 
contained. Peaceful coexistence between Bions and Terrans proved impossible. The ensuing Bion Wars are known 
for their brevity -- and violence.
In 2832, the Coalition ordered complete Bion dismantlement and instituted Terran's renowned Council of Peace -- a
military defense force inferior to none....Unknown to the Coalition, a few Bions survived and assembled on a 
distant planet called Fury.
The Bion plan is to seize seven more Coalition planets whose resources will help them attain their ultimate goal -- 
total domination of space from the Bion Fury outpost. As a member of Terran's Council of Peace, it's your mission 
to stop them. 

See also
Locating targets, checkpoints, and tunnels



Weapons

Your ship can hold seven weapons but you begin with only one, the ServoKinetic Laser. You'll never run out of 
ammo for the SKL, but you're going to need more firepower to eliminate the adversaries ahead. You must capture 
the other six weapons during battle or locate them in subterranean spaces. 
Once you find a weapon, you choose it by pressing the key shown below.

Pres
s

To activate

1 ServoKinetic Laser (SKL) 
A direct-fire laser known as 'the
Serv.' Always available. Always 
dependable.

2 Dispersion Canon 14 (DC14) 
Fires in a spray pattern and is 
good for strafes. Even more 
powerful than the Serv.

3 Rapid-Fire Laser (RFL20) 
The twentieth iteration of the 
most powerful direct-fire laser.

4 Dead-On Missile (DOM) 
This missile shoots straight 
ahead. Aim carefully and don't 
look back. 

5 Viper (VIP) 
Its infrared will track any visible
target. Guaranteed!

6 Bion Fury Missile (BFM) 
Faster and more powerful than 
the Viper, with an 
incomparable tracking system. 
These babies do major 
damage. 

7  (FFF) 
The most deadly triple-stage 
Smart Bomb destroys everything
within range, including palm 
trees and seaweed. Restores 
shields automatically and has an
IQ of 2000, better than yours.

Tip
When you locate a weapon powerUp, the name of the weapon is displayed for a moment along with the key you 
press to activate the weapon. For example, if you harvest a Viper powerUp, the message reads:    Vipers! (5).

See also
Picking up weapons
Selecting and firing a weapon
Hiding or displaying the crosshairs



The planets

Eight planets in the Coalition are overrun by bionic evil. Your journey begins on Terran and ends -- one way or the
other -- on Fury. 

Terran

Terran wasn't always a utopia. 
Ravaged by the IP Wars and then by the Bion Wars, Terran's peace has been hard-earned. And now the Bions 
have returned....

L24-D

L24-D contains the largest repository of carbonium, an explosive with 48 times the power and damage of the 
fusion bomb. The Bions want it for their perilous missile, the BFM.

Ares

The isomorphic decay of Arean red sheol attracts wormholes -- shortcuts through space and time. The Bions plan
to mine the sheol, control the wormholes, and monopolize all intergalactic travel.

New Kroy

New Kroy is a city planet that's reputed to be impenetrable. Its buildings are grown from polyKroy, an organic 
synthetic that is transparent, grows into any shape, and is nearly indestructible.

Sebek

According to ancient Sebekian scriptures, the Death Ankh grants its possessor immortality. Seize it before the 
Bions do! You don't want an enemy that you can't kill....

Vestra

Once the penal colony for bionic insurgents, Vestra is now the Bions' military training ground. They've recruited 
their most ruthless fighters, Councilor. They want you dead! 

Tiamat

Tiamat's oceans contain the last repositories of attainable phosphorous (P), a fundamental energy source in all 
living and bionic things. Without access to Tiamat's waters, the Bions will die.

Fury

Fury is the Bion deep space outpost. Destroy this planet and you'll defeat the Bion threat! At least for now....

See also
Moving to the next planet



Tunnels

The Bions have built strongholds deep within each planet. If you survive flying into one, you have the opportunity 
to make strikes that are important to the Coalition. 
Be forewarned that tunnels are especially dangerous. Radio communications cannot reach the Coalition. Once you 
enter a tunnel, you're on your own until you exit. Your request to save will not be heard.
Tunnel entrances are often camouflaged. Battle hard and keep careful watch. The greater the danger, however, the
greater the reward.

Tips
Once you've found Turbo Thrust fuel, save a little for use in tunnels, where timing, finesse, and a serious 

burst of speed can get you past a deadly trap. 
You cannot display the Satellite Map within a tunnel. Consider displaying the Satellite Map when you exit a 

tunnel to study your new position in relation to targets and powerUps. 

See also
Locating targets, checkpoints, and tunnels
Displaying or hiding the Satellite Map
Activating Turbo Thrust



The Instrument Panel

Click on the graphic below to learn more about your ship's Instrument Panel. 

Tip
Experienced pilots use the shadow of their own ship to judge their altitude over a planet's surface. 

See also
Changing the instrument display
Displaying or hiding the Satellite Map
Locating targets, checkpoints, and tunnels
Picking up weapons
Selecting and firing a weapon
Hiding or displaying the crosshairs
Increasing shield strength
Increasing or decreasing velocity



Location Coordinates

The Location Coordinates indicate your current position within a sector. This is important to note when you think 
you may want to return to a site for further exploration, or when you want to pass along information to pilots who 
may follow in your footsteps...so to speak.



Satellite Map

The Satellite Map displays a larger geographical area than the Compass. Use the Compass to locate a mission-
critical target, then use the Satellite Map to locate other targets and tunnels in remote locations. History 
demonstrates that high-scoring pilots owe much to these detours.
Press TAB to display or hide the Satellite Map. The symbols on the Map are different than those on the Compass, 
but the colors have the same meaning. Air targets pulsate yellow to red to make them visible over maps of red 
planets.

Tip
Your ship is hidden in a security timewarp as soon as you display the Satellite Map. Take your time. Your 
disappearance only frustrates the Bions.

See also
The Instrument Panel



Objective Tracker

Programmed by Coalition headquarters, this instrument locks in on the next major objective in your mission, 
whether it's destroying an enemy target, entering or exiting a tunnel, or hightailing it to a Jump Zone for a slick 
planetary exit. 



Distance Indicator

The Distance Indicator compares your current position to that of your next major objective and shows your 
progress -- or retreat. 
Bion hits can knock your ship off course. Keep an eye on the Compass and the Distance Indicator. When the 
Indicator nears "0," be ready for action. 



Weapon Readout

Indicates the ever-ready, ever-reliable ServoKinetic Laser until you press keys 2-7 to change your active weapon. 
The other six weapons are hidden in subterranean spaces or stored in well-guarded locations.



Ammunition Inventory

Indicates the strength of your active weapon or the amount of ammunition you have onboard. Also indicates the 
amount of Turbo fuel remaining when you engage Turbo Thrust.



Shield Strength Register

(yellow register on the left)
The all-important gauge!
Enemy hits and reckless driving drain your shield strength. When the Shield Strength Register runs out, it's good-
bye galactic adventure. You'll need a powerUp or a hiding place to survive. And there are NO hiding places.
Fly like a fiend if you must, but aim well. The Bions can do a lot more damage to your ship than you can.

Velocity Register

(blue register on the right)
Indicates current speed. The register is unable to indicate the ferocious Turbo Thrust velocity, but at that speed 
you won't be reading gauges anyway.



Location Coordinates

The Location Coordinates indicate your current position within a sector. This is important to note when you think 
you may want to return to a site for further exploration, or when you want to pass along information to pilots who 
may follow in your footsteps...so to speak.



Compass and Micro-Map

In Full Cockpit view, the Compass and Micro-Map are displayed separately. In Head-Up Display, the Compass is 
superimposed over the Micro-Map. 
Full Cockpit: Compass displays targets; Map displays tunnels and powerUps.

Head-Up Display: Compass superimposed over Map to show targets, tunnels, and powerUps.

Compass and Micro-Map

A wealth of information. The next mission-critical target or checkpoint is always straight up at 12 o'clock. The 
Compass displays a red triangle when you are headed toward the next mission-critical target or checkpoint. The 
arrow rotates to reflect your current heading. The plus and minus signs indicate the following items in your 
immediate area. 

Symbol Meaning

Red Air target
Green Ground target
Yellow Tunnel entrance
Blue PowerUp
+ Object is above 

you
- Object is below 

you

Tips
The Compass leads you to mission-critical targets. The Satellite Map covers a larger geographical area and 

is useful for planning detours to tunnels and other optional targets. Press TAB to pause the action and display the 
Satellite Map.

If you are flying upside down, ground and air symbols appear on your Compass and Micro-Map as mirror 
images of their actual positions.



Objective Tracker

Programmed by Coalition headquarters, this instrument locks in on the next major objective in your mission, 
whether it's destroying an enemy target, entering or exiting a tunnel, or hightailing it to a Jump Zone for a slick 
planetary exit. 



Distance Indicator

The Distance Indicator compares your current position to that of your next major objective and shows your 
progress -- or retreat. 
Bion hits can knock your ship off course. Keep an eye on the Compass and the Distance Indicator. When the 
Indicator nears "0," be ready for action. 



Velocity Register

Indicates current speed. The register is unable to indicate the ferocious Turbo Thrust velocity, but at that speed 
you won't be reading gauges anyway.



Weapon Readout

Indicates the ever-ready, ever-reliable ServoKinetic Laser until you press keys 2-7 to change your active weapon. 
The other six weapons are hidden in subterranean spaces or stored in well-guarded locations.



Ammunition Inventory

Indicates the strength of your active weapon or the amount of ammunition you have onboard. Also indicates the 
amount of Turbo fuel remaining when you engage Turbo Thrust.



Shield Strength Register

The all-important gauge! 
Enemy hits and reckless driving drain your shield strength. When the Shield Strength Register runs out, it's good-
bye galactic adventure. You'll need a powerUp or a hiding place to survive. And there are NO hiding places.
Fly like a fiend if you must, but aim well. The Bions can do a lot more damage to your ship than you can.



Views, overview

The way you view your ship -- and battle itself -- is up to you. Choose the view of battle that you want, and then 
choose the way you want your instruments displayed. All choices are available on the View menu; shortcut keys 
are listed here.

Full Cockpit

If having a little metal around you makes you feel more secure, this view is for you. 
It also presents intense maneuvering challenges as you must really fly the ship to spot Bion targets. 

Press C repeatedly until this view is displayed.

Head-Up Display

Flight information is still readily available, but your view of the action is greatly expanded. 
Press C repeatedly until this view is displayed.

No Instruments

Total freedom -- just you and the crosshairs. (And you can even get rid of them if you want to.) 
Press C repeatedly until all instruments are hidden. 
To hide or display the crosshairs, press X.

Tip
For a quick readout of your current weapon, your current objective, and your next objective, press BACKSPACE. 

Chase

Experiencing some ergonomic issues in the cockpit? Want to feel like you're water-skiing behind a supersonic 
fighter? 
Chase View gives you a 180-degree view of the action with your ship dead center. And you can tan in the glow of 
the afterburner.

Press V repeatedly until this view is displayed.

Outside

Escape the confines of the cockpit and survey your ship from any angle you choose. 
To switch to Outside view, press V repeatedly.
To pan up/down/left/right, use the Hat Switch on your joystick. Or:

To pan Press
Up/down
Left/right
Center

- / +    (KEYPAD)
INS/DEL
PERIOD (.)

Full Screen

As much game as will fit on the screen -- the menu and taskbars are hidden and the action stretches edge to 
edge. Choose this format for a smoother graphic display. 

Press F4 to display or hide Full Screen format.

Panoramic format

Also known as letterbox format, this view gives you the fastest action possible.



Press [    ] (bracket keys) to switch between Panoramic and Full Screen formats.
Press C repeatedly to cycle through the instrument displays.
Press V repeatedly to cycle through the pilot views.



Full Cockpit

If having a little metal around you makes you feel more secure, this view is for you. 
It also presents intense maneuvering challenges as you must really fly the ship to spot Bion targets. 

Press C repeatedly until this view is displayed.



Head-Up Display

Flight information is still readily available, but your view of the action is greatly expanded. 
Press C repeatedly until this view is displayed.



No Instruments

Total freedom, just you and the crosshairs. (And you can even get rid them if you want to.) 
Press C repeatedly until all instruments are hidden. 
To hide or display the crosshairs, press X.

Tip
For a quick readout of you current weapon, your current objective, and your next objective, press BACKSPACE.



Chase view

Experiencing some ergonomic issues in the cockpit? Want to feel like you're water-skiing behind a supersonic 
fighter? 
Chase View gives you a 180-degree view of the action with your ship dead center. And you can tan in the glow of 
the afterburner.

Press V repeatedly until this view is displayed.



Outside view

Escape the confines of the cockpit and survey your ship from any angle you choose. 
To switch to Outside view, press V repeatedly.
To pan up/down/left/right, use the Hat Switch on your joystick. Or:

To pan Press
Up/down
Left/right
Center

- / + (KEYPAD)
INS/DEL
PERIOD (.)



Full Screen

As much game as will fit on the screen -- the menu and task bars are hidden and the action stretches edge to 
edge. Choose this format for a smoother graphic display. 

Press F4 to display or hide Full Screen format.



Panoramic format

Also known as letterbox format, this view gives you the fastest action possible.
Press [    ] (bracket keys) to switch between Panoramic and Full Screen formats.
Press C repeatedly to cycle through the instrument displays.
Press V repeatedly to cycle through the pilot views.



If you don't hear any sound
The Mute command may be selected.
You may need to increase the volume in the Sound Options dialog box.
The volume may be turned down on your speakers or headphones.

For details, see
Muting the sound
Adjusting sound volume
If the sound seems clipped, or the sound effects are delayed



If the sound seems clipped, or the sound effects are delayed
1 On the Options menu, click Sound Options.
2 Click the Advanced button.
3 If the sound is choppy or clipped, increase the number of buffers slightly. If there is a delay in the sound effects, 

decrease the number of buffers slightly.
4 Click Test to apply the new settings and hear the results.
5 If the sound is still clipped, increase the buffer length slightly, and then click Test.
6 Continue to experiment until the sound is smooth and timed appropriately.
You can always restore  original sound settings by clicking the Default button.

Tip
If you decrease the buffer length too much, the sound will seem choppy. 



If the graphics have less detail than you would like
1 On the Options menu, click Graphics Options.
2 Choose a higher level of quality or detail for each option. Experiment to find the balance you want between 

speed and graphic detail.
The less detail you display, the faster the flight.



If your monitor display setting is higher than 256 colors

You will achieve optimal performance if you run  in 256 colors. If you run 
 in higher color modes, you may experience severe performance degradation.
To change monitor display settings in Windows 95:

1 Double-click the My Computer icon, then double-click Control Panel.
2 Double-click Display.
3 Click the Settings tab.
4 In the Color Palette box, click 256 Color, and then click OK.

To change monitor display settings in Windows 3.1:
1 In Program Manager, double click the Main icon.
2 Double-click Windows Setup.
3 On the Options Menu, click Change System Settings.
4 In the Display box, click the driver that contains 256 colors, and then click OK.



If the graphics are not as smooth as you would like

Switch to
Full Screen format by pressing F4. (There may be a momentary interruption in the screen display while 

 switches into or out of Full Screen format.)
 - or - 

Panoramic format by pressing [    ] (bracket keys).



If game play is slower than you would like

Here's how to get the fastest flight possible: 
Switch to Panoramic format. 
Display less graphic detail as you fly.
Hit the throttle!

For details, see
Changing the view to speed up game play
Increasing game speed by decreasing graphic detail
Increasing or decreasing velocity



If the ship's instruments are not displayed

"No Instruments" is one of  instrument displays. (Hiding the instruments provides faster action and a more 
expansive view than other displays.)

To display the ship's instruments, click Instrument Display on the View menu, and then click Full Cockpit or 
Head-Up Display.

Tip

You can cycle through the instrument displays -- Full Cockpit, Head-Up Display, and No Instruments -- by 
repeatedly pressing C. 



If the cockpit is not displayed

Displaying the cockpit can be a one or two-step process, depending on the view you currently have displayed and 
the way you want to display the cockpit instruments.
1 If you can see the outside of your ship, you have Chase view or Outside view displayed. To display a cockpit 

view, on the View menu, click Pilot View, and then click Cockpit. You can also press V repeatedly until you no 
longer see the outside of your plane.

2 There are three ways to display cockpit instruments: Full Cockpit, Head-Up Display, and No Instruments. To 
choose the one you want, on the View menu, click Instrument Display, then click the display you prefer. You can 
also press C repeatedly to cycle through the displays.



If the joystick does not function correctly
You may need to calibrate the joystick. 
The joystick buttons may have been assigned customized functions.
If you are using a Thrustmaster joystick, see the README for more information.

For details, see
Calibrating the joystick 
Customizing joystick settings



If  displays a message asking for the CD-ROM

The cinematic sequences are not copied from the CD-ROM during Typical Setup or Compact Setup. You'll need to 
insert the disc to see the footage.

To skip the cinematic sequences, on the Options menu, click Game Options. Make sure the Show Videos 
check box is cleared. 

The videos include footage of your ship being launched from the mother ship and other clips from your ship's 
voyage through space. 



If the keyboard does not work as expected
You may be using the + and - on the keyboard instead of on the keypad.
Remember that the arrow keys are mapped like a joystick. Pressing the UP ARROW is like pushing a 

joystick forward: it pushes the nose of your ship down. Pressing the DOWN ARROW key is like pulling the joystick 
back: it pulls the nose of your ship up. You can easily customize these keyboard settings.

You may be using DECIMAL POINT on the keypad instead of PERIOD (.) on the keyboard.
The functions of the keys may have been customized. You can return them to the default settings, or 

customize the settings yourself.

For details, see
Customizing keyboard settings



If the + and - keys don't work 
Make sure you are using the + and    -    keys on the keypad (not the keyboard). 

For details, see
Customizing keyboard settings



If you are flying upside down and don't want to be

Pull the nose of your ship up and hold it there until you are right-side up. Or, press HOME for a barrel roll. (If you 
hold HOME down too long, the airsick bag is in the glove compartment.)
Your ship has an Auto Leveler that assists in keeping you parallel to the horizon. If you are an experienced pilot 
who loves a challenge, consider turning your ship's Auto Leveling system off. With it off, you can make sharper 
turns and take on the demands of total flight control. To turn Auto Leveling off, click Options, click Flight Controls, 
and then clear the Auto Leveling check box.



Tips
If your shield strength is getting dangerously low (and low is definitely dangerous), check your Compass for

a blue symbol. Blue indicates a powerUp and should be your first priority.
When you spot the entrance to a tunnel, immediately note its coordinates. If enemy ships succeed in 

keeping you out, you'll have an easier time locating it on a second try.
When you need to return to a target, tunnel, or powerUp, remember that you can press TAB to pause the 

action and study the Satellite Map. 
Experienced pilots use the shadow of their own ship to judge their altitude over a planet's surface. 
You get the fastest game play in Panoramic format and you still have the full range of instrument displays 

and pilot views. Switch in or out of Panoramic format by pressing [    ] (bracket keys).
Need to minimize the game quickly? Press ALT, SPACEBAR, N to pause the game and minimize.
You can't always avoid disaster, but you can buy yourself a second chance. Press CTRL+S to save the 

game BEFORE the trouble becomes terminal. Save when you approach especially risky situations and after 
achieving major targets. It is especially important to save before you enter subterranean spaces; you cannot save 
while you are underground.

For a slick, quick, evasive maneuver and a cheap thrill, try rolling left or right by pressing HOME or PAGE 
UP.

When the Objective Tracker indicates a Jump Zone, you need to stay alert for the Jump Zone AND for 
targets you want to hit before exiting the planet. For a better score, steer clear of the Jump Zone until you've taken 
care of all possible targets in the area. Once you fly over a Jump Zone, you're gone -- unfinished business or not.

Speaking of evasion, Turbo Thrust (once you find the fuel) is for impatient pilots -- those who'd rather smell
the fumes than the roses. Consider saving it for defensive maneuvers, or for a short burst of speed to get around a 
trap in a tunnel. Watch your Ammunition Inventory to monitor Turbo fuel level during a Thrust.



Glossary

-- A --
Anti-Attack Batteries
Ares

-- B --
Bion Fury Missile (BFM)
Bion Walkers
Bion Wars
Bions
BioX-C23
BY2 Ship

-- C --
Carbonium
Coalition of Independent Planets
Council of Peace

-- D --
Dead-On Missile (DOM)
Death Ankh
Dispersion Cannon 14 (DC14)

-- F --
 (FFF)
Fury

--G--
Grim Reaper

-- I --
IP Wars

--J--
Jump Zones

-- L --
L24-D

-- M --
Mitotic Kroy Ship



-- N --
New Kroy

-- P --
Pandanian Hover Craft
Phosphorous (P)
polyKroy

-- R --
Rapid-Fire Laser (RFL20)

-- S --
Scarab Fighter
Sebek
Sebekian Sail Ship
ServoKinetic Laser (SKL)
Sheol

-- T --
Terran
Tiamat
Tiger Fighter
Turbo Thrust

-- U --
Unibots

-- V --
Vestra
Viper (VIP)

-- W --
Wormholes

-- X --
X2 Crane



Anti-attack batteries are standard Bion defense artillery that fire continuously unless destroyed.



Ares contains a unique mineral in its topsoil known as red sheol. The isomorphic decay of this mineral attracts 
wormholes -- shortcuts through space and time. Because of its numerous wormholes, Ares is known as the 
"gateway to deep space."
During the IP Wars, Ares closed its wormholes for strategic purposes; the planet hoped to deter anti-Coalition 
forces attempting to control intergalactic travel. The Arean wormholes were reopened in 2832 as part of Terran's 
negotiations with the Council of Peace. 
Ares is the second planet in the fifth galaxy.



The Bion Fury Missile (BFM) is a Super Missile first developed by the Bions during the IP Wars. The BFM's 
primary activator is carbonium, a highly volatile ore that is mined from planet L24-D. Carbonium explodes with 48 
times the power and radiation damage of a fusion bomb. One BFM is often all a pilot needs to get the job done.
Use of the BFM was banned by the Council of Peace in 2832, after the Bion Wars. Evidence of its usage still exists, 
however, especially within the first galaxy, near planet Fury. If a Coalition pilot were to come into contact with a 
BFM, the missile would be activated by pressing key number 6.



The Bions, c. 2486 - 2832, were a race of bionic warriors the Terrans designed for military use during the IP Wars. 
The Bions were physically superior and programmed to be ruthless. After the IP Wars, Bion aggression could not be
contained, and peaceful coexistence between Bions and Terrans proved impossible. 
In 2832, the newly founded Council of Peace halted further Bion development and ordered Bion dismantlement. 
The Bions are assumed to be an extinct warrior class.



Bion Walkers once made up the standard Bion ground-attack force. During the IP Wars, Bion Walkers destroyed 
nearly one-fifth of the anti-Coalition population. Walkers have supreme endurance and fighting power. Some were 
known to survive numerous laser hits.
Production of Bion Walkers was halted in 2832. All remaining Walkers are believed to have been dismantled upon 
order of the Council of Peace. 



Bion Wars 2829 - 2832. The Bions were a race of superior bionic warriors that the Terrans designed for military 
use during the IP Wars. After the IP Wars ended, Bion aggression could not be contained. Peaceful coexistence 
between Bions and Terrans proved impossible, resulting in the Bion Wars. In 2832, the Council of Peace, founded 
by the Coalition of Independent Planets, intervened and ordered complete Bion dismantlement. The Bions are now
assumed to be an extinct warrior class.
The conflict between the Terrans and Bions is noted for its brevity and extreme violence. For further reading, 
please see Yasmine Craigtom Kastner's The Bion Wars: A Terminal Reality (Terran: IP Press, 2837).



The BioX-C23 was the most prized Bion fighter ship during the IP Wars. After the Council of Peace ordered Bion 
dismantlement in 2832, development of the BioX-C23 was halted. 
The last known BioX-C23 was used to transport all Bion insurgents from Terran to the Bion penal colony on Vestra. 
Pilots traveling near Vestra claim they have seen evidence of the famous fighting ship, but these rumors have 
never been substantiated.



The BY2 Ship was first built in 2811 and originally used to transport Arean red sheol. Grown from polyKroy, an 
organic mineral found only on the planet New Kroy, the BY2 is one of the few carriers that can withstand repeated 
wormhole travel. When Ares closed its wormholes during the IP Wars, the Areans reconfigured the BY2 and made it
into one of the most durable fighting ships around. A few are still in existence today.



Carbonium is an ore composite found exclusively on the planet L24-D. Coalition of Independent Planets studies 
have shown that carbonium explodes with 48 times the power and radiation damage of the fusion bomb. 
Carbonium is also the primary activator in the Bion Fury Missile (BFM). Because of carbonium's highly volatile 
molecular structure, the Council of Peace evacuated L24-D shortly after the Bion Wars. Carbonium is currently an 
illicit element, and visitation to L24-D is restricted.



The Coalition of Independent Planets (CIP) is a union of allied planets that was formed in 2829, after the IP 
Wars. The Coalition spans eight galaxies and consists of 143 planets. It functions as a federal republic in which 
power is divided between a central governing authority and the individual planets. The federal government 
consists of three branches: executive, legislative, and judiciary. The judicial branch, known as the Council of Peace,
is made up of 143 representatives -- one from each planet -- and resides on Terran.
The Coalition's primary responsibilities include issuing trade agreements between planets and galaxies, governing 
intergalactic communications, travel, and military services, and maintaining peace.



The Council of Peace (COP), founded in 2832, is the judiciary branch, military defense force, and primary 
governing body of the Coalition of Independent Planets. The Council of Peace consists of 143 representatives, one 
from each Coalition planet.
The first mandate issued by the Council of Peace was the dismantlement of all bionic warriors, ending the brutally 
violent Bion Wars. Other mandates issued by the Council of Peace include reopening the Arean wormholes for 
travel into deep space, evacuating L24-D, and restricting travel to both Vestra and Fury.



The Dead-On Missile (DOM), originally built as an air-to-surface missile (ASM) in 2478, was a Coalition favorite 
during the earlier half of the IP Wars. Although extremely powerful, the DOM only shoots straight ahead and is 
generally not used for moving targets. This missile is not guided -- but it is deadly.
If a pilot were to locate a DOM, it could be activated by pressing key number 4. Use a steady hand, take aim, and 
blast away.



The Death Ankh is a Sebekian artifact reputed to bring its possessor immortality. Originally passed down from 
Elder to Elder, the 12-inch platinum icon played a large role in conferring god-like status onto Sebekian High 
Priests. Now the Ankh is lost among the ruins, and thousands of believers make a pilgrimage to Sebek each year, 
hoping to find the renowned artifact.
"Will you see past darkness, live through death?" The Book of Thoth II  2:14:06



The Dispersion Cannon 14 (DC14) is the fourteenth iteration of the Dispersion Cannon, first designed by August
Nislon during the IP Wars. Often compared to the ServoKinetic Laser and the Rapid-Fire Laser 20, the DC14 is a 
first-class antimatter laser. Designed to fire spray patterns only, the DC14 is not recommended for long-distance 
targets.
If a Coalition pilot were to locate a DC14, it could be activated by pressing key number 2.



The  (FFF) is the most deadly triple-stage, fission-fusion-fission, Smart Bomb to date. Invented by Felix 
Wannamaker III, the 
 puts the BFM to shame. The FFF is unique in that its detonator issues an ionic antimatter that causes the 

automatic restoration of Coalition shields.
The FFF is highly valuable and extremely rare. Coalition ships are only able to carry one FFF at a time. During 
wartime, Coalition pilots reserved the lucky number 7 as the key to activate this supremely powerful bomb. 



Fury is a quarantined planet at the border of Coalition territories. Ironically known as "the laughing planet," Fury's 
atmosphere prohibits surface living of any kind. Although many sightings of activity on Fury's surface have been 
interpreted as volcanic activity, as reflections of the sun's rays from misguided spaceships, or as various 
meteorological phenomena, some sightings remain unexplained by investigators.
Fury is the thirteenth planet in the first galaxy.



The Grim Reaper was the first fighting ship invented by Bion warriors. Designed for speed, precision, and 
durability, and distinguished by its ability to think, the Grim Reaper was an awe-inspiring craft. No other fighting 
ship has ever had as much success in strategic warfare. 
When the Council of Peace (COP) ordered the dismantlement of all Bions in 2832, several members of the COP did 
not want to include the Grim Reaper as part of the dismantlement. The Reaper was considered too fine an 
example of bionic ingenuity. These COP members were overruled, however. Today, aside from a few privately 
owned ships held by collectors, the Grim Reaper exists as a museum artifact that can only be seen on Terran.



The IP Wars, 2482 - 2829, were a series of interplanetary conflicts fought among 13 galaxies. The Bions, a warrior
class Terran developed for military use, proved invincible during these conflicts and helped Terran and its allies win
the wars. The Coalition of Independent Planets was founded in 2829, after the conclusion of the IP Wars. 
The Coalition spans eight galaxies and consists of 143 planets.



Jump Zone is a term used in describing emergency interplanetary travel. During the IP Wars, Jump Zones enabled
fighter pilots to travel to their next mission immediately, whether on the same planet or on another planet. Jump 
Zones proved particularly useful on planets lacking wormholes. How Jump Zones function remains classified 
information, and Jumps are only available to Coalition members during times of extreme need.



L24-D contains the only repository of carbonium in charted space. During the IP Wars, the Bions mined the ore, 
using it as the principal component of their fusion missile, the Bion Fury Missile (BFM). After the Bion Wars, the 
Council of Peace ordered the evacuation of L24-D. The planet is now uninhabited and visitation is restricted.
L24-D is the seventh planet in the fifth galaxy.



The Mitotic Kroy Ship was originally designed on New Kroy by Sergeant Eric Washole during the Bion Wars. Like 
the BY2 Ship, the Mitotic Kroy Ship is grown from polyKroy. polyKroy's unique molecular structure enables the 
Mitotic Kroy Ship to divide evenly into two when fired upon, and regrow as two individual ships, thus posing a 
double threat.
For further reading, see Amy Danan Crow-Evans', "Uniting the Ship: A New Role in Mitosis," Organic Synthetics, 
Volume 32, June 2832. 



New Kroy, also known as the City Planet, has a highly unusual surface composition. Land masses in the shape of 
buildings grow from polyKroy, an organic synthetic that exists just below the planet's crust. polyKroy is a 
transparent synthetic that grows quickly into any form and is nearly indestructible. 
New Kroy enjoys a comfortable economy because of its vast polyKroy mines. polyKroy is used to build the BY2 
Ship, the Mitotic Kroy Ship, and many off-planet housing structures and utilities, including radar dishes and 
telecomps.
New Kroy is the eighth planet in the eighth galaxy.



The Pandanian Hover Craft, an especially lightweight airplane, is used primarily on Sebek. Originally designed 
as a private plane, the Pandanian Hover Craft is especially suitable for landing on sandy terrain.



Phosphorous (P) is a nonmetallic element discovered in 1674 by Hennig Brand. It is extremely poisonous, and in 
solid form appears as a yellow to white, waxy substance. Because phosphorous ignites spontaneously when 
exposed to air, it is stored underwater. The major source of phosphorous is the mineral apatite, found in 
phosphate rocks. The principal use of phosphorous is in compounds in fertilizers, detergents, insecticides, soft 
drinks, toxic nerve gasses, pharmaceuticals, and dentifrices. Phosphorous compounds are essential in the diet. 
Phosphorous is a component of Adenosine Triphosphate (ATP), a fundamental energy source in living and bionic 
things, and of calcium phosphate, the principal material in bones and teeth. 
Tiamat's oceans contain the last repositories of attainable phosphorous.



polyKroy is an organic synthetic found beneath New Kroy's crust. It is transparent, grows instantaneously into 
any shape, and is nearly indestructible.
polyKroy's unique molecular structure allows for even division and instantaneous regrowth. As a result, polyKroy is
used as a building component for the BY2 Ship, the Mitotic Kroy Ship, and numerous off-planet buildings, radar 
dishes, and telecomps.



The Rapid-Fire Laser 20 (RFL20) is the twentieth iteration of the most powerful direct-fire laser used by the 
Coalition. Designed by Felix Wannamaker III as a forward-firing laser, the RFL20 is excellent for attacking moving 
targets. And like other lasers, the RFL20 regenerates its own ammunition.
During wartime, Coalition pilots always reserved key number 3 for the RFL20, as this laser was considered the 
'lucky laser.'



The Scarab Fighter was first built in the late 25th century and epitomizes the height of Sebekian ship design. 
The Scarab Fighter is colored in Sebek's royal colors, blue and gold, and was originally used to protect caravans 
transporting precious alloys and gems.
For further reading on Scarab Fighters, please refer to Jo Marco Thoth's autobiographical work, Flying the Sapphire 
and Gold: Aboard the Scarab Fighter (Sebek: IP Press, 2622).



Sebek is known for its adherence to ancient Egyptian texts found on Terran before the IP Wars, and for its ruling 
class, the Elders, who model themselves after Egyptian gods. Specific rituals practiced on Sebek date back as far 
as 40,000 years. 
Central to Sebekian belief is the annual search for the Death Ankh, a 12-inch platinum icon that is supposed to 
grant its possessor immortality. It is now lost among the ruins, yet each year, thousands of believers make a 
pilgrimage to Sebek, hoping to find the ankh. Originally passed down from Elder to Elder, the Death Ankh played a
large role in conferring godlike status onto Sebekian High Priests.
Sebek is the third planet in the third galaxy.



Sebekian Sail Ships are noted for their extreme weight (nearly 20 tons) and primitive design. In early Sebekian 
history, an Elder always accompanied a Sebekian Sail Ship. The belief was that without an Elder aboard, the Sail 
Ship could not stay aloft. Today, Sebekian Sail Ships commonly accompany all river barges and are the primary 
communications link between Sebekian air and ground forces.



The ServoKinetic Laser (SKL) is a heat-generated, forward-firing laser. Self-replenishing and inexpensive to run,
the SKL earned the nickname 'the Serv' during the latter half of the IP Wars. Designed by Sergeant Lee Washole 
during the IP Wars, the motto for the Serv is "can't work it too hard."
During the IP Wars, Coalition pilots always reserved key number 1 for the SKL. The SKL is traditionally a fighter 
pilot's first choice in ammunition.



Sheol, also known as red sheol, contains a peculiar molecular structure that destabilizes remarkably as it decays. 
The isomorphic decay of this mineral attracts wormholes -- shortcuts through space and time. Sheol can also be 
stockpiled and used as an attractor for wormholes ranging anywhere in size from 0.5 to 2 billion light years long. 
Sheol is unique to Ares, giving the planet its distinct red color. Its unusual characteristics make Ares the gateway 
to deep space.



Terran is the seat of the Council of Peace, the judicial branch of the Coalition of Independent Planets. Noted for its
temperate weather, unrivaled system of government, and beautiful surroundings, Terran is considered the 
Coalition's utopian planet. However, Terran's history has been anything but idyllic. Ravaged first by the IP Wars 
and then by the Bion Wars, Terran's peace has been hard-earned.
Terran is the third planet in the fifth galaxy.
For further reading, please see Alexandra Heather Cote-Knopf's treatise, "Dystopia No More: An Analysis of 
Terran's Democracy," Political Seizures, No. 9, Spring 2832.



Tiamat is one of the few known water planets. Unique to Tiamat's oceans are large repositories of attainable 
phosphorous, a fundamental energy source in all living and bionic things. Tiamat is the sixth planet in the fourth 
galaxy.



The Tiger Fighter was designed by Felix Wannamaker III during the Bion Wars. Although inherently unstable in 
design, Tiger Fighters are extremely agile. They rely on computer-aided fly-by-wire control to maintain flight 
stability, and mark the continued improvement of low-flying strike aircraft, air-to-air combat, and close support of 
ground forces.



Turbo Thrust contains an additive that, when mixed in small proportions with fuels, modifies their properties and 
makes their use more effective -- indeed, 2080% more effective. This amazing advent in transportology could 
make wormholes unnecessary for intergalactic travel. Still undergoing CIP and military testing, Turbo Thrust is not 
yet available on the common market. 



Unibots were formerly a subdivision of the Bion Walkers, the standard Bion ground-attack force. During the IP 
Wars, the Bion ground force destroyed nearly one-fifth of the anti-Coalition population. In combat, Unibots were 
noted for their extreme agility and high speeds. Production of Bion Unibots was halted in 2832 following the 
Coalition of Independent Planets' joint decision with the Council of Peace.



Vestra is an artificially constructed planet, originally built as a penal colony for bionic insurgents. Designed by 
Felix Wannamaker III, Vestra is the only planet to mimic the properties of an asteroid. Wannamaker used the 
asteroid design to inhibit the possibility of Bion escape. He named the planet 'Vestra' as a variation on 'Vesta' -- 
the brightest asteroid in charted space.
Vestra is the fourth planet in the second galaxy.
For further reading, please see Edward Robert Epps' Asteroid Design  (Terran: IP Press, 2829).



The Viper (VIP) is long-range guided missile directed by an inertial navigation system. It uses an infrared 
guidance system that homes in on heat sources, such as engines, and is sensitive enough to detect heat caused 
by friction. The VIP infrared detector, designed by Leon Mussel IV, locks onto the heat emitted from the target, so 
that, after launching, it requires no guidance by an operator. Thus, the VIP is often referred to as a "fire-and-forget"
missile. 
If a pilot should locate a very important VIP, it could be activated by pressing key number 5.



The Discovery

Wormholes were first discovered by Feynman Tipler Benford-Hawke in the late 20th Century. While analyzing 
dark matter -- massive compact anomalous halo objects -- Benford-Hawke discovered the existence of 
gravitationally negative anomalous compact halo objects (GNACHOs) (Landis, p. 2). These objects are now also 
known as negative mass, or "white holes," since their behavior and structure seem opposite to that of black 
holes. Benford-Hawke detected their existence by the bending of light due to gravity -- an effect now known as 
the "gravitational lens" (Landis, p. 1). Unfortunately, samples of negative mass are very short-lived and "pinch" 
off so quickly that they could not be examined for decades -- but their potential use to connect two distant 
regions of space could not be ignored.
In 2032, Kit Horne and his graduate students at Taltech turned the problem of pinch-off around. They wanted to 
know what form of matter is required to hold a wormhole open, so no pinch-off occurs. They discovered "exotic 
matter" -- highly stressed matter, consisting of enormous tensile strengths. The tension or pressure of exotic 
matter exceeds its energy density (Price, p. 4). At the time, Arean red sheol's molecular structure and isomorphic
decay had not been thoroughly analyzed. It was believed that exotic matter existed only under conditions of 
extraordinary pressure in the early universe -- stabilized by what is now known as loops of negative-mass cosmic
string (Landis, p. 2). The discovery of red sheol as a highly stressed matter proved Thorne right; sheol stabilizes 
a wormhole's mouth.
A traversable wormhole is known as the negative counterpart to a black hole, thus the designation "white" hole 
(Price, p. 5). (According to astrophysics, negative pressure fields drove the expansion of the universe during its 
inflationary phase. The mass of negative energy the wormhole needs is exactly the amount that would be 
needed to form a black hole if it were normal, positive energy.) The amount of negative energy required for a 
traversable wormhole increases and decreases with the linear dimension of the wormhole mouth. One meter 
cube entrance requires a negative mass of approximately 10^27kg (Price, p. 5).
Ares, known as the gateway to deep space, retains the most reliable wormhole transport system because of its 
unique topsoil, sheol, which is one of the few exotic matters known today.

Traversable wormholes 

The first probe to traverse a wormhole occurred in December 2380, traveling from Ares, in the fifth galaxy, to 
Tiamat, in the fourth galaxy. After waiting 17 years and sending more than 20 probes through different 
wormholes, scientists on Ares finally received the historic reply from Tiamat on April 23, 2473. The message: 
"Greetings." Contact with life from another galaxy had finally been made.
Emile Randel was the first life form to traverse a wormhole. He departed Ares on April 23, 2569, and arrived at 
Tiamat on June 26, 2569. Travel that would formerly have taken eons was accomplished in months.

Time travel and wormholes

Although much research is still being done as to whether wormholes can enable time travel, the accepted 
conjecture is that they cannot -- primarily because of the physical mechanisms that enforce Chronological 
Protection Conjecture (CPC) (Price, p. 6). The mouths of a wormhole, with a forced clock difference, cannot be 
brought near enough together to allow a traveler to attempt a violation of causality. Gravitational and quantum 
field effects increase as the two ends of a wormhole approach the critical point, and either induce mutual 
repulsion or collapse the wormhole (Price, p. 6).
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The X2 Crane, c. 2670, is a form of the early tower or cantilever crane. Working at speeds previously deemed 
impossible, the X2 Crane can build an atmoscraper in less than a day. 
The X2 Crane is distinguished by its ability to think as well as build, and was the first bionic crane invented.
For further reading, please see Mark Brett Gupta's essay, "Intelligent Reality," Interview, Issue 2092, February 
2670.
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